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Getting Started

Read this First
Welcome to ProIcon, a powerful programming language

that’s packed with features to help you solve complex
problems quickly.

ProIcon is a high-level, general-purpose programming
language that’s rich in string and list processing capabilities.
ProIcon’s novel expression-evaluation mechanism produces
quick, neat solutions to even your most complex problems.

ProIcon is an enchanced version of the Icon programming
language that was developed at the University of Arizona.
ProIcon’s added features were designed and implemented by
Mark Emmer and Ralph Griswold.

Before You Do Anything Else . . .

First make backup copies of your original ProIcon disks.

Then install ProIcon on your Macintosh. You’ll find
complete installation instructions starting on page 1-
2.

After that, read A Guide to the Manual starting on
page 1-3.

Knowing Your Macintosh
You should know generally how to operate your Apple®

Macintosh® computer, how to use the mouse and the menus,
and how to open documents, copy files, and install applica-
tions on your hard disk. If you need help, consult the
manuals that came with your Macintosh.

Backing Up
Your ProIcon
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Installing ProIcon
ProIcon requires System Version 6.0.1 or higher and at

least 400 KB of free memory; we recommend 1MB RAM.
The memory-monitoring application, MemMon, requires an
8-bit color or gray-scale monitor. MemMon is not needed to
write or run ProIcon programs.

Installing ProIcon is easy. First decide where you want it
to reside. We suggest that you create a folder named ProIcon
just for that purpose. When you’ve done that, copy the
contents of the two ProIcon 2.0 disks to this folder. The
disks look like this:

Configuration
Requirements

ProIcon Disks
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If you’re short of space, you may not want to include
everything. All that’s absolutely necessary is the ProIcon
application itself. However, if you don’t include ProIcon
Help (which must be in the same folder as the ProIcon
application or in your System folder), you won’t be able to
use online help. If you don’t include ProIcon Runtime 2.0,
you won’t be able to run previously compiled Icon programs
directly but instead will have to run them from the ProIcon
2.0 application.

README is a text file that contains last-minute notes
about things that didn’t get into this manual. You can open
README with any text editor or ProIcon. Be sure to read
this file; it may contain important information. You may wish
to print a copy to keep with your ProIcon documentation.
There also may be important README files in folders.

The Samples folder on the first disk contains sample Icon
programs and some interesting data. The External Fucntions
folder on that disk contains HyperCard XCMD and XFCN
material as well as samples for ProIcon 2.0’s external func-
tion interface (see Appendix D).

The MemMon 2.0 folder on the second disk contains a
separate application for viewing memory management in
ProIcon (see Appendix E). There also are sample files.

A Guide to the Manual
This manual is divided into four parts:

• The introduction that you’re reading.

• A User’s Manual that describes the ProIcon applica-
tion for the Macintosh.

• Supplementary material on Icon, which goes beyond
the basic reference: The Icon Programming Lan-
guage.

• Appendices and an index.

The remainder of this part tells you more about ProIcon in
a general way, including its relationship to the Icon program-
ming language and a special introduction to Icon for readers
familiar with the SNOBOL4 programming language.
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The User’s Manual begins with a quick tour of ProIcon,
then introduces you to compiling and running programs, the
online help facility, entering and editing text, and menu
reference.

Part three contains a guide to the most current version of
the Icon programming language and special features of
ProIcon, as well as a mini reference manual.

The appendices cover character codes, international string
comparison, Icon language checklists, external functions,
memory monitoring, and references.
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More About ProIcon

If You’re New to Icon ...
Icon is an exciting,  high-level, general-purpose program-

ming language that has unusual features like high-level
operations on strings and structures, pattern matching, goal-
directed evaluation, dynamic typing, and run-time creation
of data structures. Icon’s rich set of operations and control
structures and its powerful expression-evaluation mechanism
give you the ability to write concise solutions to complex
problems easily and quickly.

You can use Icon for rapid prototyping of large systems or
for quick reformatting of data, for problems in artificial
intelligence, for text analysis, or for quickly changing com-
plex files.

Icon was developed at The University of Arizona. It’s the
most recent language resulting from a long line of research
that produced languages like SNOBOL4. On the surface,
Icon looks a lot like many other modern programming
languages. It has a syntax similar to that of C and Pascal, and
it has many of the traditional control structures you’ve come
to expect, but Icon is much more powerful. It has genera-
tors, expressions that may produce more than one result, and
it has goal-directed evaluation, which allows many complex
computations to be expressed in concise and natural ways —
searching for solutions is done automatically.

Icon is a rich language. It has an extensive repertoire of
operations on strings of characters and supports a variety of
sophisticated data structures. The way Icon evaluates expres-
sions allows many programming tasks to be expressed more
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naturally and concisely than they can be in most other
programming languages.

This richness makes it easy to write programs that perform
complicated tasks. Consequently, there’s a lot you need to
know in order to learn to use Icon effectively. Fortunately,
you can get started with just a small part of the entire
language. Then, to use Icon’s capabilities to their fullest,
you’ll want to learn more. Learning Icon can be fun, too.
Icon has lots of new ideas and is full of exciting features.
You’ll not be bored.

A few words about strings and structures: As everyone
knows, the first computers were designed to solve numerical
problems — the computation of trajectories, orbits, and so
forth. It wasn’t long before the potential of computers to
manipulate symbolic data like equations and natural language
was recognized. Arranging data in more complex ways like
trees and lists followed — and a whole new world of compu-
tation was opened.

While Icon has the usual capabilities for numerical compu-
tation, its real strengths lie in the manipulation of symbolic
data and structures. In Icon, symbolic data is represented by
strings (sequences) of characters. Virtually every kind of data
can be represented by strings — everything from the text of a
manual like this to mathematical formulas. Text files on
computers are just strings. Icon’s repertoire for string
processing provides many ways to analyze and synthesize
strings. Analysis operations make it easy to find patterns in
text, things like words and parenthesized expressions.
Synthesis operations make it easy to build up complex strings
out of simpler ones and to format them in any desired way.

The key to managing complex data is organization.
Structures provide this facility. Different situations and
different kinds of data need different kinds of organizations.
Icon offers several kinds of structures for diverse needs. Lists
allow values of any kind (not just characters) to be arranged
in sequence and accessed by position. Lists also can be
accessed like stacks and queues for programs that need to
handle data in these ways. Icon also provides sets, which are
unordered collections of values. Operations on sets like
union and intersection provide easy ways to handle problems
that deal with common attributes and properties. Icon has
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more, including tables that provide associative lookup using
keys of any type. Icon also lets you build up complicated
structures of your own. There is no end to the possibilities.

Many real-world problems have more than one solution.
Sometimes it’s necessary to select among those solutions to
satisfy a constraint or to get a solution to a larger problem.
Icon provides a very powerful method for doing this.
Expressions, called generators, can produce sequences of
values. Goal-directed evaluation causes generators to pro-
duce results to reach combinations that satisfy larger require-
ments.

In short, Icon is a powerful, high-level programming
language. The things it allows you to do quickly and easily
make programming more fun and less of a chore. And being
able to do complex things so easily may encourage you to try
tasks you’ve always wanted to do but couldn’t face in other
programming languages. Icon may well expand your pro-
gramming horizons.
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Icon for SNOBOL4 Programmers  

If you’re a SNOBOL4 programmer, you’ll find that Icon 

has many of the familiar features of SNOBOL4. Some of 
these features are cast in somewhat different ways in Icon. 
Since Icon evolved from SNOBOL4, it has a lot of features 
that SNOBOL4 doesn’t. It also lacks some of the more 
esoteric features of SNOBOL4. The main differences 
between the two languages are described in the following 
sections. 


Syntax 


As you probably know, SNOBOL4 has a syntax all its own. 
It has several different statement types that focus on a subject 
on which operations are performed, such as assignment and 
pattern matching. SNOBOL4 has no control structures for 
expressing looping or selection; it relies on conditional 
operations and gotos to control the sequence of execution. 
Although this mechanism is very general, the need to 
fabricate loops, for example, makes programming tedious. 
It’s also difficult to write SNOBOL4 programs that are ‘well 
structured’ — programs that are easy to understand and 
modify and that are free from sneaky bugs in control flow. 
SNOBOL4 programs also are monolithic. Despite the facility 
to define functions, all the statements are really part of the 
whole program. 


An Icon program, by contrast, consists of a set of modules 
— procedures that are logically and physically distinct from 
each other. Thus, a program to be divided into its logical 
components and even be kept in a number of different files.


An Icon procedure consists of expressions. Expressions, 
unlike statements, are made up of other expressions; there 
are no sharp demarcations as there are with statements. Icon 
has several control structures that allow common forms of 
expression evaluation to be cast in standard, understandable, 
and well-structured ways. Icon doesn’t have labels and gotos. 
It doesn’t need them. 


If you are familiar with a language like Pascal or C, you’ll 
probably not have much trouble phrasing your programs in 
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terms of Icon’s syntax. Otherwise, you’ll need to spend some 
time learning how to write programs using control structures 
without labels and gotos. Copying a file provides a compari-
son. In SNOBOL4 it is


  


	 read	 OUTPUT = INPUT	  :S(read)




while in Icon, it is

 


 while write(read())


Both are short and the logic is the same; they just look 
different. 


Success and Failure 


As the preceding example suggests, Icon uses the SNOBOL4 
concepts of success and failure to control program flow. In 
this, you have an advantage over a person who knows only 
programming languages like BASIC and Pascal, and for 
whom the idea of failure may be completely new. In Icon, as 
in SNOBOL4, the failure of an operation prevents evaluation 
of other surrounding operations. While failure is used to 
select conditional gotos in SNOBOL4, failure is used to 
drive control structures in Icon. For example, a conditional 
assignment in SNOBOL4 might look like this:


 


	 	 i = LT(i,j) j	 	 :S(next)

	 	 i = 0

	 next


In Icon, it looks like this

 


if i < j then i := j else i := 0


Once you get used to it, you’ll see how similar the use of 
success and failure is in SNOBOL4 and Icon. In fact, as the 
example above illustrates, the control structures of Icon just 
use implicit gotos and labels — you don’t have to write them 
yourself as you do in SNOBOL4. 


Pattern Matching 


One of the most distinctive features of SNOBOL4 is 
pattern matching and its repertoire of built-in patterns from 
which you can build more complex ones of your own.
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 Patterns provide a high-level of abstraction that describes 
the structure of strings without, for the most part, the need 
to specify how matching is actually done. In the strengths of 
patterns lie their weaknesses. It’s difficult to specify the 
matching process if you need to, and most of the rest of the 
facilities of SNOBOL4 are not available in pattern matching 
except by using awkward and contrived constructions. 


Icon approaches the problem of pattern matching in a 
somewhat different way. Instead of having patterns, Icon has 
matching functions. Icon focuses more on the ability to 
express how the matching is done than it does on the de-
scription of what is matched. This allows all the features of 
Icon to be used in pattern matching, but at the expense the 
high-level of abstraction that SNOBOL4 patterns allow. 


For example, writing out the comma-terminated substrings 
of a string in SNOBOL4 might be done this way: 


     


	 	 P = BREAK(",") . OUTPUT LEN(1)

next	 S ? P =  	  :S(next)               


In Icon, it might look like this:

 


   s ? while write(tab(upto(',')))

     do move(1)


The point is that in SNOBOL4 you think of a pattern that 
matches the desired string, while in Icon you specify how to 
match the desired string. Granted, the two methods look 
similar; it’s the viewpoint that’s different. It’s worth noting 
that Icon allows any operation in the matching process, while 
SNOBOL4 doesn’t. In SNOBOL4, for example, you can’t 
just make an assignment to OUTPUT; you have to use a 
different operation that associates the name OUTPUT with a 
pattern. 


Actually it’s possible to capture SNOBOL4’s concept of 
patterns in terms of Icon procedures, although the method 
for doing so requires discipline and adds overhead in execu-
tion time. For example, you could write an Icon procedure 
that does the matching shown above:


 


procedure p()

   while write(tab(upto(','))) do

      move(1)

end
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and use it as if it were a pattern:

 


   s ? p()


A word of advice here: Trying to write pattern matching in 
Icon the way you would in SNOBOL4 often leads to 
frustration and awkward programs. It’s much better to spend 
the time getting used to the way Icon does pattern matching 
and to use Icon for its strengths rather than to try to force it 
to do things the way SNOBOL4 does. 


Scope 


Scope is a technical term that refers to the portion of a 
program in which an identifier is known and in which its 
value is accessible. At first glance, you may not see the 
differences in scoping of identifiers in SNOBOL4 and Icon. 
There are significant differences, however. 


In SNOBOL4, every identifier is known throughout the 
entire program. There is no distinction between global and 
local identifiers. If an identifier is  an argument  or is “local” 
to a defined function, its value is saved when the function is 
called, a new value is assigned, and the old value is restored 
when the function returns. The current value of the identi-
fier, however, is available to the entire program. This is a 
form of  “dynamic scoping”. 


Icon, on the other hand, has two kinds of identifiers: 
global and local. Global identifiers are available to all the 
procedures in the program. Local identifiers, however, come 
into existence when a procedure is called, are accessible only 
within that call of the procedure, and are destroyed when the 
procedure returns. This kind of scoping is called “static”. 


There are advantages and disadvantages to both kinds of 
scoping. Dynamic scoping makes it trivially easy to associate 
identifiers with patterns, as in


	 BREAK(",") . OUTPUT 


and allows such patterns to be used throughout the program. 
You can’t do this in Icon, since local identifiers come and go 
and there may be several with the same name. However, 
there’s no way for a defined function in SNOBOL4 to have 
an identifier all its own that no other function can change. 
Icon’s scoping is more conventional than SNOBOL4’s. 
More than likely, you’ll not notice the difference, although 
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with Icon’s scoping you’re less likely to have obscure bugs 
that result from two procedures accidentally sharing the same 
identifier. 


Data Structures 


Some of Icon’s data structures are very similar to those of 
SNOBOL4. For example, Icon has tables that are nearly 
identical to those of SNOBOL4; you should have no trouble 
using Icon’s tables if you are familiar with those of SNO-
BOL4. Icon’s lists are similar to SNOBOL4’s arrays, al-
though Icon’s lists have only one dimension. Icon’s lists, 
however, can grow and shrink and be used as stacks and 
queues. Icon also has sets, which are just collections of values 
— very handy for cases where you want to keep a collection 
of things together. For example, to write out all the different 
words in a file using Icon, the following will do:


 


words := set()

every insert(words,nextword(f))

every write(!sort(words))


Here nextword(f) is a procedure that generates the words 
from the file f. The last line of this program segment may 
look mysterious. It hints at the power of Icon. 


What’s New with Icon 


In addition to the features mentioned above, Icon has 
many features SNOBOL4 doesn’t have. Perhaps the most 
exciting and useful feature is the ability of an Icon expression 
to generate a sequence of values. While a SNOBOL4 
expression can only fail or succeed, an Icon expression may 
fail, produce a single result (succeed), or generate many 
results. Generation is particularly useful for operations that 
naturally have several results, such as the position at which 
one string occurs as a substring of another. (You may sense 
the germ of this idea in the few SNOBOL4 patterns that can 
match in more than one way.) 


Generators lead to all kinds of interesting possibilities and 
give Icon’s expression evaluation a two-dimensional charac-
ter, as opposed to programming languages in which every 
expression produces exactly one result. It’s here that you’ll 
find the most interesting aspects of Icon and discover how 
they can be used to cast complex operations in natural and 
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concise ways. Here’s just a hint. The following example 
writes all the common positions where s1 is a substring in s2 
and s3:


 


every write(find(s1,s2) = find(s1,s3))


What’s Missing in Icon 


Icon lacks some of SNOBOL4’s most powerful features — 
the ability to modify a program during execution, the ability 
to compile and execute strings on the fly, and the ability to 
redefine functions and operators dynamically. These features 
of SNOBOL4, while very powerful in terms of what you can 
do during program execution, are also expensive in terms of 
the implementation and the kind of program structure 
needed to make them feasible. 


If you’re used to these esoteric features of SNOBOL4, you 
may be disappointed initially when programming in Icon. In 
most cases, the same results can be achieved in Icon by using 
different techniques. For those things that can’t be recast in 
Icon, you may want to continue using SNOBOL4. How-
ever, there also are things you can do easily in Icon that have 
no natural counterpart in SNOBOL4. Most programmers 
who know both SNOBOL4 and Icon do most of their pro-
gramming in Icon. 
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About the Name “Icon”
As a Macintosh user, you may think that using the name

“Icon” for a programming language is misleading or possibly
a subtle pun. Actually the choice of “Icon” as the name for
the programming language you are about to use has nothing
to do with the Macintosh. The name was chosen in 1976,
before the word came into use to describe the pictograms
that identify files and functions on the screen of the Macin-
tosh and other computers.

Naming a programming language is more difficult than
you might think. Should the name be an acronym derived
from a descriptive phrase (like FORTRAN)?  Should it try to
connote some salient property of the language (like EASy)?
Should it honor some important person (like Ada)? Should it
be clever and catchy (like Spitbol)? Or what?  There are other
considerations. Is the name easy to remember? What kind of
images does it evoke? Is it easy to spell? Easy to pronounce?
Distinctive? Pleasant?

 The name “Icon” for this programming language is not
an acronym (you might be able to dream up a suitable
phrase, though), and it has no special meaning (but you
might well conjure one up). It was chosen to be short, crisp,
and uncomplicated. And because the designers had run out
of other ideas.  Had they foreseen the use of the word “icon“
for those little pictograms, they certainly would have picked
another name.

Granted, the name for the language may evoke the wrong
image and be taken for something it isn’t. Unfortunately, a
name once chosen, published, and put into use is not easily
changed. In the end, such names really mean nothing in
themselves and you’ll quickly forget the confusion. However,
you may find yourself having to explain the problem to your
fellow Macintosh users more than once.
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A Quick Tour
In this chapter you’ll see how ProIcon works and how to

create, run, and correct Icon programs. This is just a start –
there’s more information in the chapters that follow.

Start ProIcon by double-clicking on its icon. You’ll see the
ProIcon menu bar and an open window waiting for a new
program:

The name Untitled-1.icn identifies a window that hasn’t yet
been given a name and saved in a file. Before you go any
further, it’s a good idea to name the window and connect it
to a file that will be saved. Pull down the File menu and
select Save as ... :
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You’ll get a file dialog box that lets you navigate to the
folder in which you want to save your program and specify
its name:

The file name for an Icon program must end in .icn. Suppose
you want to name your program hello.icn. Enter hello.icn in
the box and select Save.



A Quick Tour 3-3

The title of your program window changes accordingly:

Now you’re ready to enter a program. Keep it simple to start
with, such as:
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When you enter this program, you’re using the ProIcon 
editor. It’s a program editor, so you type return at the end of 
every line of the program. ProIcon’s editor follows the Apple 
Human Interface guidelines. If you’re familiar with other 
Macintosh editors, ProIcon’s editor should seem very natural 
to you. Chapter 6 contains detailed information about the 
ProIcon editor. For now, just do what comes naturally.


Now you’re ready to run your first ProIcon program. Pull 
down the Run menu and select Compile Window:


The cursor changes to a “spinning beachball” while ProIcon 
compiles and links your program. Your program then 
executes and the output pops up in a window named Inter-
active:
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Now you can change your program. Suppose you want to
know what version of ProIcon you’re running. Add two lines
so that you have

The error and location also are noted in the Interactive
window following the previous output:

The compiler finds the error in line 4 when it’s looking for a
parenthesis to complete line 3 and does not find it. Close the
window named Compilation Error to get rid of it. Notice

To run this program, use the .-K shortcut that you saw in
the Run menu. Oops – there was a mistake in the program:
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that the cursor is positioned at the line of your program
window where the compiler found the error. Generally
speaking, the line where an error is detected is not exactly
where you made the mistake; the compiler can’t find an error
until something actually syntactically incorrect occurs (you
could have had the missing parenthesis at the beginning of
line 4, for example).

Correct your program and run it again to be sure it’s right.
When you’re finished, save your program, if you want, by
selecting Save from the File menu. If you close the program
window without saving changes, you’ll be asked if you want
to save your modified program.

When you’re finished with a ProIcon session, leave the
application by selecting Quit from the File menu (or use the
.-Q keyboard shortcut).

That’s the basic idea. Enter a program (or bring in an
existing one using Open... from the File menu), run it, make
corrections and re-run it as necessary, and save your program
when you’re finished.

Of course, there’s a lot more to ProIcon. The next chapter
describes more features of ProIcon.

Read on!
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You’ll get a file dialog box that lets you navigate to the
folder in which you want to save your program and specify
its name:

The file name for an Icon program must end in .icn. Suppose
you want to name your program hello.icn. Enter hello.icn in
the box and select Save.
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The title of your program window changes accordingly:

Now you’re ready to enter a program. Keep it simple to start
with, such as:
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that the cursor is positioned at the line of your program
window where the compiler found the error. Generally
speaking, the line where an error is detected is not exactly
where you made the mistake; the compiler can’t find an error
until something actually syntactically incorrect occurs (you
could have had the missing parenthesis at the beginning of
line 4, for example).

Correct your program and run it again to be sure it’s right.
When you’re finished, save your program, if you want, by
selecting Save from the File menu. If you close the program
window without saving changes, you’ll be asked if you want
to save your modified program.

When you’re finished with a ProIcon session, leave the
application by selecting Quit from the File menu (or use the
.-Q keyboard shortcut).

That’s the basic idea. Enter a program (or bring in an
existing one using Open... from the File menu), run it, make
corrections and re-run it as necessary, and save your program
when you’re finished.

Of course, there’s a lot more to ProIcon. The next chapter
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Compiling and
Running Programs

In the last chapter you saw the basic ideas for compiling,
running, and modifying ProIcon programs. ProIcon is a
powerful tool that provides many facilities to help you
build applications written in ProIcon. You’ll want to use
some of these facilities as a regular part of your work with
ProIcon. You may need other facilities only in special
situations. This chapter starts with a description of facili-
ties that you will probably use a lot. Facilities for special
situations are near the end of this chapter.

Compilation and Linking
When you compile a ProIcon program (using, for

example .-K), three processes normally take place: first
compilation proper, then linking, and finally execution.
The compilation phase converts your program into an
intermediate form. Linking converts the intermediate files
to an executable file. The executable file is then run.

You’ll notice the Run menu has two options that are
checked by default: Link after Compile and Run after Link.
As long as these options are checked, all three processes
take place, one after another. You can, however, stop after
any process. For example, if you uncheck Link after
Compile (by clicking on it in the Run menu), ProIcon stops
after compiling your program and you get two intermedi-
ate files as a result (they are deleted if you link after
compiling). These intermediate files have the suffixes .u1
and .u2 in place of the suffix .icn in the name of your
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program.

Libraries
You might ask: “What good are intermediate files?” The

answer to this question is suggested by the linking process
mentioned above. The ProIcon linker can combine inter-
mediate files from several programs to produce a single
executable file. This is useful for making libraries of
procedures that can be included in many programs.

 If you want to include intermediate files from a library
program, you must have a link declaration that names the
library in your program. For example, suppose you have a
collection of procedures for doing rational arithmetic and
you place them in a file rational.icn. Compile this file but
don’t link it (as described above). Now suppose you want
to include this library in a program in approx.icn. This file
should start as follows:

link rational

procedure main()
   . . .

When you compile and link approx.icn, the intermediate
files from rational.icn are included by the linker, so you
can use any procedure contained in rational.icn within
approx.icn. You’ll notice that just the name rational is used
in the link declaration (no suffix). And, of course,
rational.icn must not contain a main procedure, since only
one main procedure is allowed in a program and a pro-
gram that includes library procedures normally provides
it. You can link several libraries, either with separate link
declarations or by using a comma-separated list, as in

link rational, input, output

If the name of a library does not satisfy the syntactic
requirements for an Icon identifier, it must be enclosed in
quotation marks, as in

link "long-arith"

You can also place intermediate files for library proce-
dures in different folders and arrange for ProIcon to find
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them automatically without having to specify the paths.
The way to do this is discussed later in this chapter.

Icon Applications
Executable files produced by the linker have names

corresponding to the Icon program files from which they
are produced, but without the .icn suffix. For example, the
executable file that results from compiling and linking
hello.icn is named hello. You can run an executable file
without having to recompile the program. Select Run File
... from the Run menu. You get a file dialog showing the
available executable files. When you select one and
complete the dialog, it runs.

So far, you’ve been working inside the ProIcon applica-
tion. You don’t have to be in the ProIcon application to run
an executable file. Just launch it from the desktop. This lets
you build applications in ProIcon and run them as you
wish. You can also give such applications to others. It is
necessary to include the file ProIcon Runtime because it’s
needed to support executable files. It’s another file to
remember, but there’s a good side to it — all executable
files use the same ProIcon Runtime and hence executable
files are small.
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Program Options
Selecting Program Options ... from the Options menu lets

you turn some program options on and off:

Icon does not require you to declare local identifiers. If
an undeclared identifier appears in a procedure and there
is no global declaration for it anywhere in your program,
the identifier is taken to be local. This saves having to
write a lot of declarations. It can be dangerous, however.
You may intend an identifier to be local,  but there may be
a global declaration for it that you don’t notice. If you
check Undeclared Identifier Warning, ProIcon’s linker
issues a warning message if it finds an undeclared identi-
fier. Such messages are just warnings; they don’t prevent
your program from linking or running.

Normally, when ProIcon compiles and links a program,
it deletes the intermediate files produced by the compiler
(the .u1 and .u2 files). If you want to keep these files (to
use in a library as described earlier in this chapter, for
example) check Preserve Intermediate Files.

ProIcon offers two kinds of tracing: procedure tracing
and function tracing. Check the corresponding boxes if
you want tracing to be done automatically. A word of
caution: tracing produces a lot of output and it may be

Undeclared
Identifiers

Intermediate
Files

Tracing
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hard to find what you want. Function tracing produces
much more output than procedure tracing in most pro-
grams. While checking these options gives you tracing
without having to modify your program, you may find it
more useful to add code to your program to turn tracing
on and off selectively by setting the values of &trace and
&ftrace.

If you check Dump, you’ll get a listing of variables and
their values when your program terminates. Again, this
also can be done by setting &dump in your program.

If International Comparison is checked, ProIcon com-
pares strings using the Macintosh international compari-
son system. See Appendix B for details.

Memory Monitoring causes information about storage
allocation and garbage collection to be recorded. Checking
this box brings up an Open dialog when you run the
program for a file to hold the information. Appendix E
describes how to use the results.

Object File Launches Runtime determines what happens
when you launch an executable file from the desktop. If
this box is not checked, launching an executable file starts
the ProIcon application. If the box is checked, only the
ProIcon run-time system is activated. You probably want
the ProIcon application to be launched for your own
programs, but you’ll need to have the run-time system
launched for programs you give to others, since they may
not have the ProIcon application.

As indicated by the radio button in the Program Options
box, the options you specify normally just apply to the
current program. If you want them to apply to all pro-
grams, click on the Compiler Defaults radio button. You
also can copy from one to the other by clicking on the
Copy button.

String
Comparison

Termination
Dumps

Memory
Monitoring

Launching
Runtime

Compiler
Defaults
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Parameter Strings
Parameters can be communicated to a ProIcon program

by means of a blank-separated string that provides a list as
the argument to the main procedure. This string is entered

using the Parameter String ... entry from the Options
menu:

For example, if you enter the string

cyan yellow magenta black

giving

then in

procedure main(args)
   every write(!args)
end

the values written are

cyan
yellow
magenta
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black

You can include blanks in an argument by enclosing the
argument in quotation marks, as in

for which the values written are

cyan
yellow magenta
black

Path Names
For simple file names in link declarations, ProIcon

searches the folder where your program resides. If you
want to look in other folders, you may specify files by full
or partial path names.

A full path contains several elements, each separated by a
colon. A full path name begins with a disk name, then zero
or more folder names, and ends with the file name. Two
examples are:

link "hd:ProIcon:Library:rational"
link "Floppy Backup:ProIcon:test

A partial path is relative to the current working folder,
and begins with a colon, as in:

link ":Library:rational"
link ":ProIcon:test"

In both full and partial path names, two adjacent colons
mean “go up one folder” in your disk’s folder hierarchy.

Library Folders
If you use libraries of intermediate files, you’ll probably

find it convenient to keep them in one or more folders,
separate from the rest of your ProIcon work. While you
can specify the paths to such folders in link declarations,
you’ll probably find it more convenient to use ProIcon’s
library search facility.

Full Path
Names

Partial
Path Names
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When ProIcon’s linker encounters a link declaration for
an intermediate file without a full path name, it searches

for the file first in the folder that contains your main
program. If the linker doesn’t find the file there, it uses
paths specified in the Library Folders ... selection in the
Options menu. The specification of paths in the previous
section goes to the file level. Here it goes to the folder
level. To set up library search paths for folders, select
Library Folders ... :

As indicated, you can specify one or more path names,
separated by .-returns. For example:

Once these paths are entered, they are used when
linking all your ProIcon programs, even if you quit the
application and then launch it again. You can, of course,
change the paths any time you wish.

Rather than specifying individual folders, your search
paths may include classes of names. This is done by using
“wildcard” characters.

The ? wildcard character matches any single character in
a  name. Thus, A?C matches all three-character  names
whose first letter is A and whose last letter is C, such as

Wildcards
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AKC or a9c.

The ∗ wildcard character matches zero or more charac-
ters in a name. For example, A∗M matches AM or Alarm.

If ∗, ? or \ appear literally in a name, precede each with a
backslash, as in \∗, \?, or \\.

Here are some folder names as they might appear in the
search path dialog:

Library∗
R??d:Library

If you use complicated search paths, or change them
from time to time, you can record them in text files. Open
a new window in ProIcon, and type in the paths, one per
line. Save the file with a name that ends in .paths, such as
search.paths.

The Library Folders ... dialog includes a Use File button.
When you press this button, you can specify the name of
the file containing your pre-specified search paths. ProIcon
reads in the paths and uses them as if you’d typed them in
directly. The .paths suffix is mandatory.

Input and Output
  You can open any file you want from inside a running

ProIcon program. Three files that you don’t have to open
are provided for your convenience: standard input,
standard output, and error output.

Standard input is where input comes from if you don’t
specify a file when reading. Standard output is where
output goes if you don’t specify a file when writing. For
example,

while write(read())

Path Files
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copies standard input to standard output. Error output is
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used for error messages. These three files can be specified
explicitly in a program as &input, &output, and &errout.

Unless you specify otherwise, standard input is taken
from the keyboard, while standard output and error
output go to the Interactive window. You can change input
or output to the currently active window or to a file. If you
select a file that is also opened as a window, your output
goes to the window.

If you want to change program input or output, select
Program Input ..., Program Output ..., or Error Output ...
from the Options menu. Suppose you want standard
output to go to poems. Select Program Output ... :

Click on Write to File... . You get a file dialog:

 Now enter poems:

Now click OK. If you already had a file named poems,
you’d get an alert box that asks you if you want to over-
write it. Complete the dialog as usual and standard output
now goes to poems. You can change standard input or
error output in a similar fashion.

Keyboard
End-of-File

Compiler
Memory
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You can terminate keyboard input to a running ProIcon
program by selecting Terminate Input from the Edit menu
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(or by using the .–D keyboard shortcut).

Memory Management
The ProIcon compiler uses several tables for internal

computations. The default sizes for these tables are
adequate for most programs, but if you have a very large
program or one with unusual characteristics, the compiler
may run out of space in one of its tables. If this happens,
you get an error message such as

This message means that you have more global identifi-
ers than fit in the compiler’s global table. While you might
be able to reorganize your program to work around this
limit, you also can make the table larger. Select Compiler
Memory from the Options menu and pull down the
hierarchical menu it points to:

As you see, there are a lot of sizes you can change. Select
Global table as indicated by the error message:

The current size of the global table is highlighted. You
can edit this text to change the size. The size to use de-
pends on your program and the specific table involved.
You could count the number of global identifiers in your
program, but you might just as well double the current
value, which probably will be enough with some to spare.

As indicated by the radio button in this box, the size you

specify normally just applies to the current program. If
you want it to apply to all programs, click on the Compiler
Default radio button. You also can copy from one to the

Execution
Memory



4-14  Compiling and Running Programs

memory allocation setting by clicking on Prev or Next.
When you’re satisfied, click on OK to have the changes
take effect. You may also click on Cancel if you decide not
to make the changes.

other by clicking on the Copy button.

You can navigate to the previous or next compiler
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ProIcon manages execution memory automatically. It
keeps track of values your program no longer needs and
“collects” them when it needs space to create new values.
Consequently, you can process a large amount of data as
long as it doesn’t all have to be kept around at one time.
Some programs, however, need to keep a lot of strings and
structures, such as tables of words and their counts. Such
programs may need larger regions for storage than are
provided by default. If this happens, you get an error
message, such as

You can increase the size of the offending region to give
your program more room. Select Execution Memory from
the Options menu:

Proceed as described for compiler memory: in this case,
select String region from the hierarchical menu:

The current default size is shown. Deciding on a new
size may take some thought and possibly experimentation.
If you have a lot of RAM, you can set the value consider-
ably larger and not worry about it.

If you don’t have a lot of RAM, you may need to search
for a value that works, possibly reducing the sizes of other
regions. Windows also require memory. You may need to
close unnecessary windows if  the total amount of RAM is
a problem. If you’re running under MultiFinder, you may
need to adjust ProIcon’s partition size; see the section on
MultiFinder later in this chapter. In any event, it’s neces-
sary to know something about how ProIcon uses memory.

The block and string regions are where the values your
program produces are kept. The other sizes refer to other
aspects of program execution.

The evaluation stack is used to hold temporary values
during generation and recursive procedure calls. Overflow
of the evaluation stack usually indicates runaway recur-
sion. You should look for a problem in your program if
this happens. If the stack really needs to be larger, you can
increase its size as for other regions. If the problem is
runaway recursion, however, increasing the stack size
only increases the time until overflow occurs.

Every co-expression contains its own evaluation stack.
Co-expression stacks normally are smaller than the main

Blocks and
Strings

Evaluation
Stack

Co-Expressions

Qualifiers
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evaluation stack. If overflow occurs in a co-expression, it
may be necessary to increase the size of co-expression
blocks. (Most of the size of a co-expression block is de-
voted to its stack.) Since stack overflow in a co-expression
may not be detected, it can cause other program malfunc-
tions. If you’re using co-expressions that perform recursive
procedure calls or deeply nested generation and your
program has problems, suspect such overflow.

The qualifier pointer region is used only during garbage
collection to keep track of strings in your program that
need to be saved. If you get an error message that indicates
that this region is not large enough, increase the size. You
should check your program to see if it really needs to have
a lot of different strings at the same time.

There is another side to all this: If you have only a small
amount of RAM, the default region sizes may be too large
to even get started and you may have to reduce the default
sizes to be able to run ProIcon programs at all. If this is the

case, start with a small program and reduce the string and
block region sizes to smaller values until your program
runs. You also can decrease the size of the evaluation stack
and qualifier pointer regions if necessary. Reducing the
size of co-expression blocks only has an effect if you use
co-expressions. You can reduce all sizes substantially and
still be able to run small programs that don’t need lots of
memory. However, the kinds of applications for which
ProIcon is best do require lots of memory. It’s impractical
to try such applications without enough memory,  and,
while ProIcon can work over a wide range of memory, if
there really is not enough memory, it will work poorly or
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not at all.

Output Limiter
Because window data is held in memory, writing a large

amount of data to a window may exhaust memory.
ProIcon provides a way of limiting the number of text
lines that are retained in a window.

The limit can be controlled from your program by
selecting Window Options … from the Options menu,
which gives you this dialog box:

You can turn output limiting on or off as indicated and
also specify the number of lines retained when it is on.

For example, suppose you set the limit to 350 lines, and
your program  begins  writing  output  to  the  window
Untitled-3.icn. As new lines appear at the bottom of that
window, the window contents scroll up and are available
for review by moving the thumb in the vertical scroll bar.
When the 350th line is output, ProIcon silently discards the
top one-eighth of the lines in the memory file. The file now
contains 306 lines of data, and the process is repeated each
time the 350-line limit is reached.

Persistent Settings
Most options you set apply only during a session in the

ProIcon application. Once you quit ProIcon, they are
discarded. When you launch ProIcon again, they’re set
back to the default values.

 Program options and memory settings are persistent.
The paths you specify for library searches are also persis-
tent. Persistent settings are saved in the ProIcon Profile in
your system folder. You can delete this file if you want to
get back to ProIcon’s initial settings.

Launching Executable Files
If you hold down the option key when click-launching

an executable ProIcon file, you get a dialog that allows you
to set the parameter string, specify input and output files,
and adjust execution memory regions.
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Stopping ProIcon
You can terminate program compilation, linking, or

execution by selecting Stop from the Run menu. Caution:
ProIcon cannot stop all forms of program activity immedi-
ately.

If you want to suspend compilation, linking, or execu-
tion, select Pause from the Run menu. You then can
resume by selecting Continue.

MultiFinder
ProIcon is MultiFinder friendly. It will run in the back-

ground if you let it. When it needs input, a small icon
alternates with the ð  symbol on the menu bar.

When running under MultiFinder, you can adjust
ProIcon’s memory partition by highlighting the applica-
tion on the desktop and using Finder’s Get Info command.
The number at the bottom of the screen is the partition
size.

You can launch another application from ProIcon using
launch() as described in Chapter 10. If MultiFinder is
active, your ProIcon program continues to run.
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Online Help
ProIcon provides an online help facility that allows you to

get information about functions, operations, and other
aspects of ProIcon without leaving the ProIcon application.
Online help is not a substitute for this manual or the Icon
book, but it can give you quick answers to many questions
that come up while writing and debugging programs.

There are several ways that you can get online help. One is
to select Online Help from the top of the ð  menu. This gives
you a two-level heirarchical menu:

Help Menu
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The first level, shown on the previous page, lists the cate-
gories for which help is available. The next level lists specific 
items. Suppose, for example, that you select String Scan-
ning:


 

Selecting a

Category
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Selecting an
Item

Now you can select a specific item, such as &subject:
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A window with information about &subject pops up:

Another way to get help is to select text in the currently
active window, such as the name of a function in a program
on which you’re working. Suppose, for example, you’re
working on the program shown below and you want to
know more about the function put. Select put by dragging
over it or double clicking on it:

Help Windows

Help Lookup


